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Introduction

Through the aid of a compiler, a program written in a computer language, such as C++, is
turned into machine code, which is executed on the computer. However, going from an idea to a
program that works successfully takes a lot of time and effort. It may take several rewrites of code to
get the program to work correctly. To accomplish this, students must learn a disciplined approach to
organizing the code and learn how to trace their programs. The purpose of this manual is to help the
student develop the skills to organize program coding and develop sound techniques for finding and
isolating errors. Here you will learn how to trace the code step by step, so that it becomes clear where
the problem is and why your program does not execute properly. This is called debugging the
program. Hand tracing is useful in helping beginners understand where the bugs are and correct the
program appropriately. Automatic tools have also been developed to help you trace programs that you
have written and will be an important tool as your programs become more complex. This type of tool is
called a debugger. A debugger lets you pause a program, while it is in the middle of running, and
watch what is going on. Some debuggers work as command-line line debuggers, but newer debuggers
have a nice graphical user interface, which is useful in helping you watch variables that you have
defined as the program executes. The graphically-based debugger environment is part of what is called
the Integrated Development Environment (IDE). The purpose of these notes is to introduce you to
this environment and help you learn how to use it as you develop and hone your programming skills.

A debugger cannot solve your problems for you. It is merely a tool to assist you when
programming. You should first attempt to read over your code and using paper and pencil analyze the
code to get an understanding of what is going on. Once you have gotten an idea of where in your code
you have an error, you can then set the debugger to watch certain variables in your program. Watching
your code will show you step by step how your program is being executed.

The debugger that you will use is part of an Open Source free IDE called Code::Blocks, which
we have found easy to use and is described in these notes. Code::Blocks has a C++ editor and compiler.
It will allow you to create and test your programs from one easy to use application. We hope these
notes will assist you in making programming more enjoyable and help you develop better
programming skills.

You may find additional information regarding Code::Blocks at: http://www.codeblocks.org/

A complete manual for Code::Blocks is available here: http://www.codeblocks.org/user-manual
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Installation of Code Blocks

Step 1: Download the Software

In order to install the Code::Blocks IDE as well as the MinGW compiler, you must download it. If you
are using either Windows XP or Windows Vista download the installation programs from here:

http://downloads.sourceforge.net/codeblocks/codeblocks-8.02mingw-setup.exe

Save the file to your hard disk and remember its location. Proceed to the next page in order to continue
the installation.

If you are using Mac OS X or Linux, please see Appendix | for installation instructions.
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Step 2: Install the Software

Next, open (click on) CodeBlocks install file and the CodeBlocks Setup will begin installing as
follows:

L1 codeBlocks Setup =100 =]

Welcome to the CodeBlocks Setup
Wizard

This wizard will guide vou through the installation of
CodeBlocks,

It is recammended that vau close all ather applications
before starting Setup. This will make it possible to update
relevant system files without hawving to reboat your
computer,

Click Mext ko continue,

Zancel |

Click Next.
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Ll codeBlocks Setup =101 x|

Licenze Agreement

Please review the license kerms before installing CodeBlocks,

Press Page Down to see the rest of the agreement,

GMNL GEMERAL PUBLIC LICEMSE il
Yersion 3, 29 June 2007

Copyright (C) 2007 Free Software Foundation, Inc, <hbkbpe /fFsf . org) »
Evervone is permitked to copy and distribute verbatim copies
af this license document, buk chanaging it is not allowed,

Preamble

The GMU General Public License is a free, copyleft license Far
software and ather kinds af works, ;I

If wou accept the terms of the agreement, click I Agree to continue, You must accept the
agreement ko install CodeBlocks,

rullsoft Imstall System w2, 25

< Back. I I Agree I Cancel |

Select | Agree.

Ll codeBlocks Setup =101 x|

Choose Components
Choose which features of CodeBlocks waou want ko install,

Check the components you want to install and uncheck the components wou don't want to
install, Click Mext to continue,

Select the type of install Skandard: Core plugins, core bools, and core

Or, select the optional - [ Default install
cu:umpii:unents wioll wish ko - B Cantrib Plugins
install: :

i.[ ] 2B share Config
MiniEY Compiler Suike

— Descripkion

Space required: 102.5ME Position waur mouse over a component ko see jts

descrption,

rullsoft Imstall System w2, 25

< Back. I Mexk = I Cancel

Take the default settings by pressing Next.
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Ll codeBlocks Setup =101 x|

Choose Install Location
Choose the folder in which toinstall CodeBlocks,

Setup will install CodeBlocks in the Following folder, Toinstall in a different Folder, click Browse
and seleck anather Falder, Click Install ko skart the installakion,

Destination Folder

_:\Program Files\CodeBlocks Browse, .. |

Space required: 102,5ME
Space available; 7.1ME

rullsoft Imstall System w2, 25

< Back. I Iristall I Cancel

Take the default folder to install CodeBlocks to and then select Install.
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Step 3: Customization of the Code::Blocks User Interface
(Optional)
The following steps will enable you to customize your IDE so that it is will be consistent with what
your instructor will be using in class:
1. Configure the editor:
a. Choose Editor from the Settings Menu
b. Under the General Setting tab
i. Change the font size to 10 or 12 point (Use the Choose button.)
ii. Under Other Options place a check mark the following options:
e “Show line numbers”
e “highlight line under caret”
e “highlight occurrences”
Your screen should now look like the figure:

Configure editor

General settin

Al Fonk
: |  Thisz is sample text
/ Default encoding when opening files: iWINDOWS-1255 w '

eneral settings TAE options End-of-line options

[Juse TAB characker []show end-of-line chars
¥ TAE indents Strip krailing blanks
TAE size in spaces: | 4 [ = End files with blank line
' |:| Ensure consistent ECLs
".—\ End-of-line mode: ECR LF |» .
Falding Indent options Other options
Auka indent []word wrap
| Smart indent [[Juse PoSTE style for RegEx searche:
Backspace unindents [TJuse advanced RegEx searches
[] show indentation guides show line numbers
. Show spaces: |NC| _v: Highlight line under caret
- - ' T [CJHome kev always maves caret ka Fir

Margins and caret Highlight: occurrences

Editor titlz is the file's
¢ "y name only {no path information)
2 (%) relative filename (ta the project fils)
l O ] l Cancel ]
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c. Select the Margins and Caret tab on the right of the window.
i. Choose “Visible line” from the Right margin hint
ii. Set the Hint Column to 72

Your screen should now look like the figure:

Configure editor

Margins and caret

| " Left: rmargin
| Width For line numbers (in chars): |5 | : [ ] Dvnamic setting
/ Add/remove breakpoints by left-clicking
I Right: margin
General settings i G |
Right margin hint: | Yisible line “ |
: I -~
\ Hint calurmn: |72 ! -
v-\ Caret
Width: 1 %
Falding |—| =
§ Period (in miliseconds): J
i3 = ( ) 0 500 500
21 3
by .
3 3
SENW S
E: |
Margins and caret
.
»
oK ] [ Cancel
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d. Choose the Source formatter Caret tab on the right of the window.

i. Select K&R from the style menu (Note: Your instructor may use a different style
— if so, examine each style and choose the style that matches your instructor’s
preferred indentation.)

Your screen should now look like the figure:

.Cnnfigure editor

Source formatter

" I i i A | Style |Indentatinn || Farmatting |
Skyles Sample
Mouse Drag Scrolling
O anst namespace foospace {
EKaR int Fool) {
{:}Linux if (isBar) |
bar () :
Oahul return 1;
{:} Java + else
recurn 0O;
kKeyboard shorkcuts O Custom )
H
wxamith settings
|
-
-
— o
Source Formatker |
[ (a4 ] [ Cancel J

e. Choose OK in order to save your customizations.
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2. Configure the Help files

a. Download the C++ help file from
http://onnerby.se/~daniel/chm/cppreference.com/cpp.chm

b. Save the cpp.htm file to your c:/Program Files/Codeblocks directory

c. After saving the file, right-click on the file, choose Properties, and unblock the file so
that it will be accessible to the Code::Blocks IDE.

d. Choose Environment from the Settings Menu
e. On the tab to the left of the window scroll down to the Help Files section
f. Choose Add and enter “C++ Help”

g. Use the file browser button |[E to locate the file you have just saved. (It should be at
C:\Program Files\CodeBlocks\cpp.chm)

h. Place a check mark in the this is the default help file (Shortcut: F1)
Your screen should now look like the figure:

T
& )
" |
P A
HeaderFixup
configuration
Help files
* . class fo
5
i a
: vojaka-:j i
b "' .
Al o |C:'I.Pr0gram Files\CodeBlocks)cpp.chm |[ i ]
Thread search TIP: ${keyword) will be replaced by the word under the cursor
This is the default help file (shartcut: F1)
[ This line represents a Full command ko be executed
[l pen this file with the embedded help viewer fonky for HTML files)
|Preserve kewword case ~ |
To-do list == Default kevword value: | |
[ QK ] [ Cancel ]

i. Choose OK in order to save your customizations.

By pressing F1 you will now be able to obtain help on the word under your cursor.
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First Project

After you have finished downloading and setting up the Code::Blocks system, you can be in to write
code. Code::Blocks creates what is called a Workspace to keep track of the project you are working
on. It is possible for you to be working on multiple projects within your workspace. A project is a
collection of one or more source (as well as header) files. Source files are the files that contain the
source code for your program. If you are developing a C++ program, you are writing C++ source code
(.cpp files). Header files are used when you are creating library files (.h files). A library is a
collection of functions that are called to perform specific tasks, such as doing math, etc.

Setting up a project allows you to keep track of all the files in an organized way. When first starting
out in computer programming, generally your projects will consist of a single source file. However as
you gain experience and work on more complex projects, you will have projects containing many
source files and dealing with header files as well.

To create a project, click on the File pull-down menu, open New and then Project.

=" Start here - CodenBlocks v1.0 - O] x|
File Edit ‘Wew Search Project Build Debug wxSmith Tools Plugins  Settings Help
Mew » Empky File Ckrl-Shift-r
(4 Open Project
Cpen default workspace Build target
Recent projects » File
Recent files r Cuskam
From user template
Imnport project L S 4 P X
e
|5 save (e —
| 5aveas...
i -Shifk- s
save al files Cttl-Shift-5 c.ode- . Blocks
Save projeck
Saye prajech as,., The open source, cross-platform (DE _ILI
- [
Save project a5 user-template I
Save al projects
save workspace HlerBlocks ] U Code: :Blocks Debug | q Pk
Save workspace as.., LSkylePlugin Aukosave BYOGames CBProfiler CE_Koders ﬂ
Close workspace rd CodeCompletion CodeSnippets CodeStatistics Compiler
= Debugger FilesExtensionHandler DevPakUpdater DragScrall
G Close File T Exporter HelpPlugin cbkevBinder ScriptedWizard
= wamnith weeSmithMirne weSmithWizard WindowskPLookNFeel J
Close all files Chrl-Shifk-y Fartup scripk j
Close project
Close all projects e
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This will bring up the New from template window. Opening (clicking on) Console Application will
then allow you to write a program on the console. The other application are for developing more
advanced types of applications. After selecting Console application, click on the Go button to begin
using the Console Application Wizard.

New from template x|

Projects Categary: | <Al cakeqories j | e I

Build targeks

Files I [ = Cancel |
Zuskom L, L+
IUser templates ; ;
Code::Blocks [ application Directs Crvnarmic Link
plugin application Library

GLIPW GLUT
| & e &

Emply project  FLTE project  GLPW project  GLUT project  Irrlicht projec

Fd e @ =~

Ogre project Openial QT4 project SDL project Srarbwin
praject praject

' ™ — Miew as
S - ,
. J ' % Large icons
-
Tk abim likezeo LA im 22 0 TLIT 1 Sraikk e Abdidmake .
< | _’|_I " Lisk

WWhey are some wizards marked in red? |

1. Select a wizard bype Firsk on the left
2. Select a specific wizard From the main window (Filker by cateqories if needed)
3. Press Go
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Console application

E Console

Welcome ko the new consale applicakion wizard!

This wizard will quide wou to create a new consale application

When vou 're ready to proceed, please click "MNext”, ..

= Back Mext =

Cancel

Press Next to go to the next step.
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Console application x|

Please select the Folder where ywou wank the new project

m Co nso Ie ko be created as well as its title,

Project kitle:
IFirsI: Program

Folder ko create project in:

Project filename;

IFirsI: Program

Resulting filename:
I-::invalil:l path =

< Back Hexk = Cancel

Start by filling in the Project Title. You will notice that the Project Filename automatically becomes the
same name. If you wish, you can change the filename, but for simplicity leave it as is. To specify the
location of the folder to contain the project, click on the “...” button (selected in the picture above) and
browse to a folder on your drive to store the project. Generally, you can save it in My Documents.

Press Ok after selecting My Documents

15 of 61



Console application = x|

Please seleck the compiler to use and which configurations

m Cu nso Ie wyou wank enabled in vour project.

Conpiler

barLl ST Compiler

¥ Create "Debug" configuration: IDebug

"Debun” opkions
Cugkput dir,: II::in'l,DeI:uug

Ohjects oukput dir.: IDI::j'I,DeI:uug

¥ Create "Release” configuration: IREIease

"Release" options

Cukput dir, II:nin'l,ReIease

Chjects ouktput dir. : IDI::j'I,ReIease

< Back I Mext = I Cancel

When the directory for your project has been selected, the system will return to the Console
application. As shown, Code Blocks will create a directory called First Program (Project Title) and
returns your selected directory in Folder to create project in. Inside that directory will be the Project
filename (First Program) and a resulting filename, which contains a Code Block Project file (.cbp)
named First Program.cbp. The project title and project filename in this case are the same. However,
they need not be the same and these names can be altered. Click on the Next Button when done.

The next window to pop up will be the Compiler screen. This specifies where the Debug and Release
compiled versions of your program will be placed. Leave this setting alone and press Next.
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Console application x|

m Console

Flease seleck the language wou wank ko use.

Flease make a seleckion

.

< Back I Finish I Cancel

The next window allows you to choose the language that you will use. Select the language as C++, then
press Finish.

17 of 61



m [First Program] - Code:Blocks ¥1.0 = -0 x|
File Edit “ew Search Project Build Debug  wxSmith  Tools  Plugins  Setkings  Help

| eE &2y [P RO E

1 |
Q B ﬁ@@huildtarget:lmbug j
B0 OO

Projects | Svmbols |

m First Program
+-F=% Sources

|g Opened Files

J j Code:Blocks ] U Code:;EBlocks Debug |

Loading: ASkylePlugin Autosave BYOGames CEBPrafiler CB_Koders
Classiwizard CodeCompletion Codesnippets CodeStatistics Compiler
copwstrings Debugger FilesExtensionHandler DewPakUpdater DragScroll
Erviars Source Exporter HelpPlugin chkeyBinder Scripkediiizard
ToDoList wecamith wixSmithMime wieSmithiwizard WindowsyPLookMNFeel
Funning startup scripk

ILv

R

Welcome ko | | |

The system will then return to the [First Program] window and you are ready to write your program.
It should be noted that the Build target is Debug, which will allow you to use the debugger to find
errors. In the Management area of the screen (Shift-F2 toggles the Management display), you will see

the files that are part of the project in the Projects tab. To see the source files, click on the plus [+]’s to
expand the Workspace and its subdirectories.
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a [First Program] - Code::Blocks ¥1.0 -0 =|

File Edit Yiew Search Project Build Debug  wxSmith  Tools Plugins Settings  Help

 HES LY (AR R
| |
‘0 P S 2] 8 |uidtarget: pebug =]
BB LR Ee O

IT

Projects | Symbols |

EO ..............

m First Program
== Sources
e j mainlcpp

Ig Opened Files

J,,_ﬂ Code::Blocks ] X} Code::Blocks Debug

Loading: AskylePligin Autosave BYOGames CEPrafiler CE_Koders ﬂ
ClassWizard CodeCompletion CodeSnippets CodeStatistics Compiler
copystrings Debugger FilesExtensionHandler DevPakldpdater DragScroll
ErvYars Source Exporter HelpPlugin cbkeyBinder Scriptedwizard

ToDoList weeSmith weSmithMime wiSmithhfizard WindowsxPLookNFeel J
F.unning startup scripk

WKL

Welcome ko

Under Sources, there is a file called main.cpp, which is automatically created for you when you build a
console application.
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Adding Files To Your Project

If you have a project with additional existing files, go to the Project menu and select “Add files.” This
will bring in the files associated with your program. You also have the option to Remove files,
performing Build options and to Set programs’ arguments....

'. [First Program] - Code::Blocks »1.0

=101 %]

Fil= Edit “iew Search | Projeck Build Debug  wxSmith  Tools  Pluging  Settings  Help

] = H é | t Add files. ..

I Add Files recursively. ..

: Remave files. .. jl
P OIOI

Project tree k 3
nl-FE:I LE ?}}' 1’ ?} {' Set programs’ arguments. ..

Build options
Properties

-2 Sources

|g Opened Files

J j Code:Blocks ] U Code: :Blocks Diebug |

Loading: ASkylePlugin Autosave BYOGames CBPraofiler CE_Koders ;I
lasswizard CodeCompletion CodeSnippets Codestatistics Compiler
copystrings Debugger FilesExtensionHandler DevPakUpdater DragScrall
Errears Source Exporker HelpPlugin cbkeyBinder Scriptedywizard

ToDaList weeSmith weSmithMime weSmithiWizard Windows<PLookMFeel J
F.unning starbup scripk

Add files kot

N/ EX
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Add files to projeck... ﬂﬁl

Laak jn: Ia First Program j - = E3-

H'First Praogram.chp
[C# main.cpp

] Ju]
.
by Documents

My C

File name: I

ey Metworl: P

j Open I
j Cancel ‘,.fL

Files of bpe: f 4 fles %)

Clicking on Add files to project, will bring up a window so you can browse to where your files that

you wish to add are. Select any additional file you want to add and press Open. The file will then be
added to your project.

If you are creating a new file, you can use the pull-down File menu and open an empty file.
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[First Program] - Code::Blocks »1.0

File Edit Wew Search Project Build Debug  wxSmith  Tools  Plugins  Settings  Help

Mew

=101 %]

Empky File Ckrl-Shift-
4 Zpen k-0 Project
Open default workspace Euild target
Fecent projects » File
Recent files » Zuskorm

Irnport praject

Fram user template

5 Save (o
L'-] SEYVE 35 ..
Save all Files Zhr]-Shifk-5

Saye projeck

Saye project as...,

Save project as user-template
Save all projects

Save workspace
Save workspace as..,
Close workspace

HlexzBlocks ] U Code: :Blocks Diebug |

LSkylePlugin Aukosave BYOGames CBProfiler CE_Koders ;I
rd CodeCompletion CodeSnippets CodesStatistics Compiler
= Debugager FilesExtensionHandler DevPakUpdater DragScrall

6 Zlose file o o [
lmse all files L o
Close project
Close all projects

ource Exporker HelpPlugin chkeyBinder ScriptedWizard

wSmikh weSmithMire wxSmithWizard WindowssPLookNFeel J
rartup scripk

N/ EX

File, New, Empty file.

You will be asked if you want to add this file to the project.

Add file to projeck

Choose Yes.

Code Blocks will ask for a file name to save the file as:
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Save file ilil
Save jn: Ia First Pragrarm j - £ 3~

[ main. cpp

Higtory

File name: Isample.cpp j Save
Save as type: |E£E++ filez j Cancel |
%

Give a name to the file. Pick a name that is related to the content of the file. Here it is called
sample.cpp. C++ files need to be of the type cpp. Press Save to save the file.

Multiple selection _ O] =|
Select the targets this file should Belong to:
¥ Debug Wildzard select
¥| Release ™ . |

Toggle seleckion

Deselect Al

Selected: 2

I, I Cancel

Press Select All to have this file saved as both Debug & Release targets. Press OK when done.

A target is a type of compiled version. You can work with a debug target, which will allow you to test
the program using a debugger. A debug target will be large in size, because it has extra information in
it to allow you to test for errors. A release target is smaller in size, because it does not have the
debugging information. When you are ready to give other people (such as your Instructor) your
finished program, you should give them the release target.
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'. sample.cpp [First Program] - Code::Blocks 1.0

_|ol x|
File Edit Yew Search Projectk Build Debug  wxSmith  Tools  Plugins  Setkings  Help

| HEHS[R ¥ B OAE

EI =l

Q b Q @ 6 |Buil-:| target:lDeI:uug j

HEET YO0 O
_ sample.cpp 4 om
Projects | Symbols | q4 » 1

E--G Workspace z

El!l First Program
EHE. Sources

e main. cpp
- sample.cpp

I; Opened Files

L ﬂ Unfitledz J J Code:Blocks ] U Code: :Blocks Diebug |

Loading: ASkylePlugin Autosave BYOGames CBPraofiler CE_Koders
lasswizard CodeCompletion CodeSnippets Codestatistics Compiler
copystrings Debugger FilesExtensionHandler DevPakUpdater DragScrall
Errears Source Exporker HelpPlugin cbkeyBinder Scriptedywizard

F.unning starbup scripk

ToDaList weeSmith weSmithMime weSmithiWizard Windows<PLookMFeel J

=

|E:'|,D|:n:umenl default

Line 1, Column 1 Insert

|Rea|:|,|"-.-'-.-'rite

v

The Sources now has sample.cpp as a source file in addition to the main.cpp file.

Since the sample.cpp is not needed for your project, please remove it.
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'. sample.cpp [First Program] - Code::Blocks ¥1.0 - |EI|5|
File Edit “iew Search | Project Buld Debug  wxSmith  Tools  Plugins  Settings  Help

P = e | & Add Files. ..
Add files recursively. ..

I Remove files. .. : | jl
: Q P Q [a 6 |E Projeck kree 3 =
l-FE' LE' ?}\' ?f, ?} {' Set programs’ arguments. ..
_ Build options 1 X

Projects | Symbols | Propetties
El--o Workspace E

El.l First Program
== Sources

. main.cpp
- sample. cpp

I; Opened Files

"1 Untitled? J /| Code:Blocks ] X} Code::Blocks Debug | 4 P

Loading: ASkylePlugin Autosave BYOGames CBPraofiler CE_Koders ﬂ
lasswizard CodeCompletion CodeSnippets CodeStatistics Compiler
copystrings Debugger FilesExtensionHandler DevPakUpdater Drag3croll
ErrvYars Source Exporter HelpPlugin cbkeyBinder ScriptediWizard

ToDoList weeSmith wexSmithMime weeSmithitizard WindowsxPLookMNFeel J
Funning startup scripk j

Inserk |Reau:|,l"~.u'~.n'rite &

al | 0

|Flemu:uve File= ||:|eFau|I: |Line 1, Column 1

From the Project menu select, Remove files.

Multiple selection -0l x|
Select files ta remove From Firsk Prograrm:
main. cpp ‘Wildcard seleck

sample.cpp

Toggle seleckion
Select Al
Deselect Al

Selected: 1

Ok, | Zancel

Place a check mark next to any file(s) that you wish to remove. Press OK when you are done.
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Confirmation x|
@ Are you sure you wank ko remove these files From the projeck?

Yes Mo |

You will need to confirm that you wish to remove the file(s). Press Yes, if you are sure you want to
remove them. Otherwise press No.

'. [First Program] - Code::Blocks ¥1.0 :
File Edit Wew Search Projectk Build Debug  wxSmith  Tools  Plugins  Setkings  Help

MEN R A e e

1 =
Q b Q E 6 |Buil-:| target:lDeI:uug j
BTG OO

=101 %]

Projects | Svmbols |
E‘"O Warkspace
El!l First Program
=B Sources
b j rnain, Cpp
lg Opened Files .
L ﬂ Unkitiedz J j Code:Blocks ] X} Code::Blocks Debug | 4 P
Loading: ASkylePlugin Aukasave BYOGames CBPrafiler CB_Koders ;I
Classwizard CodeCompletion Codesnippets CodeSkatistics Compiler
copystrings Debugger FilesExtensionHandler DevPaklpdater DragScroll
Erreiars Source Exporker HelpPlugin cbkeyBinder Scriptedizard
ToDolist wesmith wieSmithMime wxSmithizard WindowsyPLookMNFeel J
Funning starkup scripk ll
|'-.-'u'eln:|:|me ko | | | | | i

You will now see an updated listing of the Sources in your file. You should now see only Main.cpp. In
the Open Files list, there may be a file called !Untitled. Please ignore this.
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To edit a file from your project, double click on it's name from Sources and it will appear in the
window with line numbers. You can now edit the file and prepare your program.

'. main.cpp [First Program] - Code:Blocks 1.0 - II:I|5|
File Edit Yew Search Projectk Build Debug  wxSmith  Tools  Plugins  Setkings  Help

P EHES Ay X0 R R
1 =
Q P Q E 6 |Buil-:| target:lDeI:uug j

r - - d'l\ L]
BEFLHREOO
Management X [ 4 b x
Projects 1 b 1 ffinclude <iostream>
E‘“O Workspace z
El.l First Program e - int maini)
. 5
= {E u:uuru:e.s 3 std:tcout << "Hello world!" << =std::endl;
o j mair. Epp [ return 0;
7 }
g
CECa— =z
Opened Files ]
1) Unkitledz J i! Code:Blocks ] U Code: :Blocks Debug | '«_.!é Search results |<1 b
Loading: ASkylePlugin Autosave BYOGames CEPraofiler CE_Koders Class\izard ;I
odeCompletion CodeSnippets CodeStatistics Compiler copystrings Debugger
FilesExtensionHandler DevPakUpdater DragScrall Ereevars Source Exporker
HelpPlugin chkevBinder Scriptediwizard TaDoList wixSmikh vweSmikbMime |
v smithiWizard WindowsXPLookiFeel lI
Domeimsa =k =vbkoe ~=vie bk
E:\Document WINDOWS-1252 Line 1, Column 1 Tnsert Readfwrite s
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'. main.cpp [First Program] - Code:Blocks 1.0 - II:I|5|
Fil= Edit “iew Search | Projeck Build Debug  wxSmith  Tools  Pluging  Settings  Help

P EAE S|4  Addfies..

Add Files recursively. ..
| =l

Remaove files. ..

Q P Q la 6 |E Projeck kree k 3
FAEME T Y Py ¢ setprograms' arguments...
IIIIIIIIIIIIIIIII Build options | 1 [ X

Projects 4] Properties kiostreaus

E‘“O Workspace
El.l First Program
== Sources

------ j main. cpp

int maini)
=
std:tcout << "Hello world!" << =std::endl;
{ return 0;

b

Lo e U ) B S T

F < | 2

S, Opened Files Messaes %

..... | MAM:ERR | CodezBlocks | % % Code:Elocks Debug I_4 Search results q4 k
L 4

b 1] Untitledz B

Loading: ASkylePlugin Autosave BYOGames CEPraofiler CE_Koders Class\izard ;I
odeCompletion CodeSnippets CodeStatistics Compiler copystrings Debugger
FilesExtensionHandler DevPakUpdater DragScrall Ereevars Source Exporker

HelpPlugin chkevBinder Scriptediwizard TaDoList wixSmikh vweSmikbMime |
v smithiWizard WindowsXPLookiFeel lI
Domeimsa =k =vbkoe ~=vie bk

et the proje WINDOWS-1252 |Lire 1, Colurnn 1 Insert | Readfwrite s

In order to check that Debug is running, you can use the Project pull-down menu and click on Build
Options.
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Project build options

Firsk Program

=10l x|

Selected compiler

| &hu G Compiler

Cormpiler |Linkﬂr I Directories | Commands I Zuskom variables I "Make" commands I

Palicy: I.ﬁ.ppend targel aptions to project opkions j

Compiler Flags IOther options I #defines I

Cateqgaries:

<Al cakegories = j

Wil Produce debugaing symbols [-g]
Profile code when executed [-pa]
Enable all compiler warnings {overrides every other setting) [-Wwall]
Enable standard compiler warnings [~
Stop compiling after first errar [-wWhatal-errors)
Inhibit all warning messages [-w]
Enable warnings demanded by skrick 190 C and 190 C++ [-pedantic]
Treat as errors the warnings demanded by strick IS0 C and IS0 C++ [-pedantic-=
W'arn iF main) is nok conformant [-Wmain]
Strip all symbals From binary {minimizes size) [-s]
Cptimize generated code (For speed) [-0]

Cptimize mare (For speed) [-01]
rintirnize ewen mnre (Far eneedt T-re _lLI
[

(0] 4 Cancel

When this is done, the Project Build options window will come up. Make sure that the Produce

debugging symbols [-g] is checked.

Press OK when done.
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'. main.cpp [First Program] - Code:Blocks »1.0 - |I:I|£|
File= Edit Miew Search Project | Build Debug  wexSmith Tools  Plugins  Settings  Help

F HEEH S| % Y| £ S Eud Crl-F9
2 Compile current file Ckrl-Shifk-F2 - -
I 5 Imaln{} v ink
, B Run Ctrl-F10
: Q p Q [a 6 |B""|d e Q. Build and run Fa
B YE T DY 7 @ | 2] Rebuid Chrl-F11
m E Clean 4 @ x
Projects | 4 b Euild workspace
E‘“O Workspace Rebuild workspace
El.l First Program Clean workspace
E-E= Sources .
P Rp—— 0 fbort world!l =< std::endl;
Errors k

Select barget. .. kv Debug

i Release
[; Opened Files M Export Makefile

e | main, cpp ) :
.. T Untitled & Build log | f I?il:ulu:l MEsSa0Es | &) Debugger L |

[>

Setting breakpoints :I

Debugger name and wersion: GHNU gdb &.3

Lt E: /DOCTTHME~]1/goets,MYDOCT~1/FIRSTP~]1 /main. cpp: &

Debugger finished with status 0O j
b
4

Build targst ' WINDOWS-1252 LLine: 6, Column 11 Insert | [Readjwirics

After clicking on done, the system will return to Main.cpp. When testing your code, make sure that
Debug is selected as the target to use. This way when you Compile your program, you will have a
Debug version available. To compile a file means to take the instructions that you have written and
translate it into machine code for the computer to understand.
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'. main.cpp [First Program] - Code:Blocks 1.0 - II:I|5|
File Edit “ew Search Project | Build Debug  wxSmith  Tools  Plugins  Setkings  Help

:  EES| % Y| £ D b Ctrl-Fa
I Compile current file Ckrl-Shifk-F2 - Imain{}l it
: B Run Ctrl-F10
: Q P Q la 6 |BU"d e Q Build and run Fa
B ME T B (T @ |2 Rebuid Chrl-F11

_E Clean 4 b x

Projects 1 b Build workspace

E‘“O Workspace Rebuild workspace
E|--.l First Program Clean workspace
== Sources .
L j Sp— 0 fbart world! =< std:endl;
Errors k

Select target... r

S— o
Opened Files e Export Makefile =

| main.cpp : :
P ﬂ Untitledz &3 Build log | \f“ IE!I:qu:I MEssanes &) Debugger L]

[>
Setting breakpoints :I
Debugger name and wersion: GHNUO gdb &3
At E: /DOCTME~]/ goetzs,MiD0OCT~1/FIRSTP~]1 /main. cpp: &
Debugoger finished with status 0 j

-
A

(Compile curr WINDOWS-1252 |Lire &, Colurnn 11 Insert | Read/wris

Compile your file from the Build pull-down menu by clicking on Compile current file (Ctrl-Shift-F9).
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'. main.cpp [First Program] - Code:Blocks ¥1.0 i - |I:I|£|

File Edit Miew Search Project | Build Debug  wxSmith Tools  Plugins  Settings  Help

EE S| % Y| kS ed Ctrl-F9

. I Compile current file Ckrl-Shifk-F3 = I

: B Run Chrl-F10

SPOIO |BUIld targe E;, U = ] |

CIEME T Dy ¢ @ | 2] Reuid Chrl-F11

m E Clean 4 b x

Projects 4 b Build workspace

E‘"O Workspace Rebuild workspace

E‘" First Program Clean warkspace
F-F= Sources .
P main.cpp 0 Bhaort world!l == =std:tendl;
Errars g
Seleck target. .. r
Kl : i

5, Opened Files g Export Makefile [r—

i | main.cpp - ;

1) Untitledz ) Bml_d Ing ¥ Build messages_ | & Debugger | 4 I
Process terminated with status 0 (0 mimates, 18 ;I
seconds)

0 errors, 0 warnings
-
Build and rur WINDOWS-1252 Line 1, Colurnn 1 Insert | Readfirite s

Test the project from the Build Pull-down menu, by clicking on Build and Run. This step will build an
executable file for you. A project build will take the compiled versions of your source files and
combine them into one program.

You are able to press F9, which is a keyboard shortcut that will build your project and run it at the same
time. As you gain more experience with the system, it will be easier to just press F9 to Build & Run
your program. The Message window will indicate if there are any errors during a compile or build
phase.
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E:"-.,Prugram Files'CodeBlocks Mightly'.ch_console_runn
Hello world?

Press any key to continue.

This is the output from my first program. Notice that besides displaying “Hello world!” it also says to
“Press any key to continue” with the program paused. Pressing any key will exit the program.

If you execute the program by going to a console window you will not see the “Press any key to
continue” message:

E:'\WINNT  system 325 cmd.exe

E:“Documents and Settingsgoetz“My Documents~First Program>'firszt program"
Hello world?

E:“Documents and Settingssgoetz“My Documents“First Program’

Notice that there are double quotes around the file name. This is because there is a space in the name. If
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you execute this program by double clicking on it's icon, the program would close right away. That is
because the pause statement is only done when you run your program in Code Blocks.

When you are done, save all your files by pulling down the File menu and clicking on Save all files.

'. main.cpp [First Program] - Code::Blocks ¥1.0 : - IEIIE[
File Edit Wew Search Project Build Debug  wxSmith  Tools  Plugins  Settings  Help

e ¢ i, R§
= Open k|- jlmainl{} v ink

Open default workspace j

Recenkt projects k

Recent files »

Irnport project 2 4 X

finclude <iostream>=

Int maini)

ctrl-shift-5 |

std:cout << "Hello world!" =< =std::endl;
Save project return| 0;

Save project as...

Save project as user-template
Save all projects

‘L

Save workspace

Save workspace as... f Build messages £) Debugger L I
Close workspace kpoints ﬂ
=2 and version: GNUT gdb &.32
€3 Close file Ctelw  |~l/goetz MYDOCU~1 FIRSTP~1 /main. cpp: &
Close all Files Chel-Shift-yy  [Fshed with status 0 j
Close project
Close all projects 11 Inserk |RE:ad,l'WritE: v
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Now you can select to save the project:

'. main.cpp [First Program] - Code::Blocks ¥1.0 : - IEIIE[
File Edit Wew Search Project Build Debug  wxSmith  Tools  Plugins  Settings  Help
[ g L, 'E"::.
= Open k|- jlmainl{} v ink
Open default workspace j
Recenkt projects k
Recent files »
Irnport project 2 4 X
finclude <iostream>=
5 save iZkrl-5
] Saveas.. Int maini)
Save all Files Ctrl-5hifk-5

std::cout << "Hello world!" =< =std::endl;

Save project

Save project as...
Save project as user-template
Save all projects

return 0O;

‘L

Save workspace
Save workspace as. .,
Close workspace

G Close File

Close all files
Close project
Close all projects

CErl-
ZEr-Shifk-b

When you exit the program, you may be asked to save the Workspace and the Layout. The Layout
refers to the placement of various windows that you may have positioned. Generally you would select

f Euild messages £) Debugger 1 [
points ﬂ
=2 and version: GNUT gdb &.32
~1 goetzs /MYDOCT~1 fFFIRSTP~1 /main. cpp: &
ished with status 0

-

11 |Insert | |RE:ad,l'WritE: v

to Save the Layout (unless you know you really do not want it saved). The Workspace refers to the
projects you are working on. It is possible for you to be working on multiple projects within your

workspace. Saving your workspace will allow you to return to the same set of projects when you next

open Code Blocks.
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To open a project

'. Code:Blocks v1.0

File Edit Wiew Search Project Build Debug  weSmith

Mew

Settings  Help

Toals

Plugins

RS

E Dpen
Open default workspace
Recenkt projects

k|-

X [

=10l x|

|

Recent files »
Import project » 1 [ X
FY
5 save (8 = —

] Saveas..
Save all Files

Ztrl-Shift-5

Code::Blocks

Save projeck

Saye projeck as, ..

Save project a5 user-template
Save all projecks

The open source, cross-platform [DE

biren - Munane: coelahloe e ..I-.-

Save workspace
Save workspace as. .,
Close workspace

i | U Code::Blocks Debug | k_.ae Search resulks |<1 3

a Close File

Close all files
Close project
Close &l projects

From the File menu select Open.

CErl-
ZEr-Shifk-b

=4

=
/
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21

Look in: Ia Firgt Program j - E‘F -
[:l::-l:lj

H'First Pragram.chp

File name: j Open

Files af ype: Code::Blocks Flrl:liEeE:t file= Cancel |
P

From the Files of type: in the window, select “Code::Blocks project files” and then select the .cbp file
pertaining to your program.

Press Open when done.
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'. main.cpp [First Program] - Code:Blocks »1.0 - | I:Ilil
File Edit Wew Search Project Buld Debug  wxSmith  Tools  Plugins  Setkings  Help

I EES[(A Y [EER[AR

I jlmainl{) v ink
Q D q. m a |Buildtarget:|Debug j : IE Uz T 3 ™ (Y e | Ol £,
Management X oo 4 b x

Projects | q bk 1

E‘“O Workspace
El.l First Program
-2 Sources

ffinclude <jiocstream>

int maini)
=
std: tcout << "Hello world!" =< std::endl;
L return 0;

;

W1 M o L

I; Opened Files ll_l LI

) main.cpp Messages %
& Build log | W Build messages | £) Debugger | 4 [
it E: /DOCTTME~]1/goets,MYLOCT~1,/debuy/main. cpp: 3 _:J
Continaing. . .
it E: fDOCTTME~]1/goetz /MYDOCT~1 /debug/main. cpp: 19
Contirnaing. . .
Program exited normallsy.
Debugger finished with status 0O
-

E:\Documents WINDOWS-1252 Line &, Colurn 11 Insert | Readiwrite 2

The project has reopened. You can get more space to see your program, if you close the Messages
window. Pressing F2 toggles the display of the messages. The Messages window has been turned off
for the remainder of this tutorial, to allow more space to be visible on the screen.

Note: You may also open a project directly from Windows Explorer by double-clicking on the file with
the .cbp extension.
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Debugging a Program

As your programs become more complicated, there will be a need to trace the program execution step
by step or place break points where you wish the program to pause. This is where a debugger is
utilized. A debugger can pause your program and you can watch the values of the variables that you
have defined.

The following is a sample program that can be traced “line by line” while watching what happens as
each line of code is executed.

'. main.cpp [debug] - Code::Blocks ¥1.0 _|I:I|5|
File Edit Wew Search Project Buld Debug  wxSmith  Tools  Plugins  Setkings  Help
T =E SR Y[R R R
I jlmainl{) Link
D D S £ 6 | buid target:|Debug “fEETIOHE0| DL
_ main.cpp 4 I X
Pﬂﬂectsl 1k 1 finclude <iostreams=
E..O w,:,rkspace Z using namespace std;
El.l debug = ) ) )
EHE Sources : int addemi{int, int);
~| main.cpp & [Jint addem{int a, int b |
7 int o
g
2 c=ath;
10
11 return c;
1z I
r 15
. Opened Files 14 int mwaini)
j main, cpp 15 =1
le int x=5, wv=2, =;
17
12 z=addemnm (x _ ¥
13 cout << = <= endl;
z0
z1 return 0;
zz !
3
Jl | 2l
E:\Documents WINDOWS-1252 Line 16, Colurn 21 Insert Readiwrite 2

39 of 61



First, it is necessary to set a place in the code to have the program pause. This is done by using the
Debug pull-down menu and clicking on Run to Cursor. The cursor should be over the first line of
code where you wish to start the tracing process. This starts the debugging process.

'. main.cpp [debug] - Code:Blocks 1.0 - | I:Ilil
File= Edit Miew Search Project Bulld | Debug  wexSmith  Tools  Plugins  Settings  Help
T EHE S| R Y| KD B Fa
I Q Stop debugger haing) ; int
A~ W Wl x| |Builu:| target:IDeI:ul L2 continue crkFr [ 3 AT I | e
|!| !!ll ! ! ! main.cy T}?‘ Mext line F7 4 o
Prujectsl 4 b 1 % Mext instruction Alk-F7
=) Workspace 2 ™ Stepinto <hift-F7
= 3
=g debug 4 4% step out Ctrl-Shift-F7
EHE Sources c
L mnair. cpp e Toggle breakpoink F5
7 E Run ko cursar
g
= Add symbiol File
10 Debugaing windows »
i; Information k
W |5 Editwatches...
0 d Fil
7 penf_r res T fktach bo process, .,
L mEIn, Cpp 15
1e Debach
17
e Send user command to debugoer
12 cout =< = <= endl;
za
z1 return 0;
2z I
z3
KN -]
Run pragram WINDOWS-1252 Line 18, Colurn 18 Insert | Readiwrite 2

The next step in debugging a program is to tell the program when to stop running so you can inspect
the results. To do this, place the cursor over the line where you want your program to stop. For
example, the cursor was placed at line 18 (which is hidden behind the menu). This is called a
Breakpoint. Now you can instruct the debugger to run the program up to the cursor's position (line
number).
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| By Documents and Settings', goetz' My Documents',debug

The program will generate a blank window. It is blank, since that program has yet to execute any line
that displays something.
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'. main.cpp [debuqg] - Code::Blocks ¥1.0 _|EI|E|
Filz Edit “iew Search Projeck Build | Debog  wxSmith  Tools  Plugins  Settings  Help

P EE O Y| & E LB Fa
I Q ey el g naing) @ ink
' © P Q2 @ |buidtarget:[Debt | continue lFr [ PO Q| L

| ! !!! !|! ! main.cy T}" Mesxt line FF 4 b om=

Projects 4 b 1 {3 Mextinstruction AlE-F7

=4 Workspace < ™ Stepinto Shift-F7
=g debug i I Step out Ctrl-Shift-F7
EHE- SOurces c
e rnair. Cpp . Togale breakpaink FS
7 LE'- Run ba cursar F+
2

o add symbiol File

Debugging windows Breakpoinks
Information 3 Call stack,

1z
W |5 Editwatches,., CPLI Registers
Opened Files 14 Disassermnbly

; . ftkach bo process, ., )

e | main.cpp 1E - Examire memary
Ehac

le Running threads

Send user command to debugger

19 cout << =z << endl;

z1 return 0O;

« | H

Wtakch vatiab WINDOWS-1252 Lirie 18, Calurnn 1 Insert | Readfwrite 2

To watch certain variables during the execution of the program, you should open the Watches window.
This will show you the variables in your code. This is accomplished by going to the Debug pull-down
menu and clicking on Debugging Windows and then Watches.
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El Function Arguments
i Mo arguments,

These are the watches that the debugger is displaying. Notice that X & y have the correct values.
Variable z has not been assigned it's value on line 18 yet. The current value is a random value.
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- Code::Blocks v1.0 =101 x|
ch Project Build Debug  wxSmith  Tools  Plugins  Settings  Hel
acal wariables = = e - i - 9 oeR
=5 AR SRy
by = 2
':_ jlmainl{} 1ink
dnction Argurnents |EiL|i||:| target:lDebug j ~|v|FEL LEL' T?' -" ?} {? 9 | :-l... 7.
‘Mo arguments.
| x main.cpp 1 F X
1k 1 finclude <iostream=
Z uwzing namespace std;
e
4 int addewmi{int, int);
5
"CRR & [lint addem{int a, int b} {
7 int c;
]
a c=ath;
10
11 return c;
1& 1
F 12
. Opened Files 14 int maini)
e j main.cpp 15 =
l& int ==L, w=2, =:
17
12 [ | z=addemx,¥] ;
13 cout <<z << endl;
z0
=1 return 0;
ZE 1
3
« | [C1
[E:\Documents WINDOWS-1252 Ling: 18, Calurmn 1 Insert | Readfwrite

Line 18 has a yellow marker on the left side. This indicates that the program has paused on that line,
which is the breakpoint.
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'. main.cpp [debug] - Code:Blocks 1.0

=101 x|

File= Edit Miew Search Project Bulld | Debug  wexSmith  Tools  Plugins  Settings  Help

ARNE N =1E T A e == Fa
I Q Stop debugger haing) ; int
A~ W Wl x| |Builu:| target:IDeI:ul L2 continue crkFr [ 3 AT I | e
Maniagement R | T Next e = PR
Prujectsl 4 b 1 % Mext instruction Alk-F7
=) Workspace Bk ste into Shift-F7
= 3
=g debug 4 4% step out Ctrl-Shift-F7
EHE Sources c
L j mnair. cpp e Toggle breakpoink F5
7 LE Run ko cursor F4
g
= Add symbiol File
10 Debugaing windows
— Information
T2 Edit wakch
r 13 it watches. ..
0 d Fil
7 PEHLT res T fktach bo process, .,
j main, cpp 15
1e Debach
17
e Send user command to debugoer
12 cout =< = <= endl;
za
z1 return 0;
2z I
z3
KN -]
Execute the r WINDOWS-1252 Line 18, Colurnn 1 Insert Readiwrite 2

To determine how your program will function when calling functions such as:

z = addem(x,y);

Step info (Shift-F7) can be selected from the Debug pull-down menu.
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s main.cpp [debug] - CodezBlocks ¥1.0 : -0 =|
File Edit Wiew Search Project Buld Debug we<Smith  Tools  Plugins  Settings  Help

T =E SR Y [EEOAR
i |
Q P q@ahuildtarget:ltmbug j l@@@ﬁ- ?}{?0|: i

_ main.cpp 4 X
Projects | L 1 finclude <iocstream>
E..O \Warkspace z uzing namespace std;
El!. debug 3 ) ) )
EHE Sources : int addewm{int, int);
©| main.cpp & [lint addem(int a, int b |
7 int c;
g
9 [x c=ath;
10
11 return c;
1z !
F 13
_ Opened Files 14 int maini)
j rnain, cpp 15 O
le int x=5, v=Z, =;
17
1la z=addemnm (x,%)
15 cout << = <= endl;
Z0
£l return 0O;
2z I
3
ol | i
E:\Documents WINDOWS-1252 Line 2, Colurnn 12 Insert Readiwrite 2

The next step is line 9.
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watches |
=-1 _:n:al wariahles
- c=16334
=)+ F nction Arguments
a=5

The arguments a and b are shown in the Watches window. Notice that the local variable ¢, which has
not been set yet, has a random value.
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a main.cpp [debug] - CodezBlocks ¥1.0 _ -0 x|
Filz= Edit “ew Search Project Buld | Debug  wxSmith  Tools  Plugins  Settings  Help
| EES|R YLD B F8
I 6 Stop debudger sddemint a, ink bl : int
‘0 B 2] € |buldtargeti[peby |2 continue ey [T Q| E
g R | iy 7 [ | e
Projects 1 F 1 {3 Mextinstruction Al-F7
1) Workspace Z ¥y Stepinto Shift-F7
= 3
=g debug 4 4% stepout Chrl-Shift-F7
EHE Sources c
- j mair, cpp . Togale breakpaink F5
7 LE'- Run to cursor F4
2
o Add symbal File
10 Cebugging windows 3
ié Information »
r 13 Edit watches. ..
0 d Fil
. F.'E“E_ res L Aktach to process, ..,
e j main, cpp 1E
16 Detach
17
e Send user command to debugger
15 cout << =z << endl;
zZ0
z1l return 0O;
2z b
23
< | [
Execute the r WINDOWS-1252 Lirie 9, Colurnn 1 Insert | Readfwrite

To proceed to the next line of code, select Next line from the Debug menu.

Pressing F7 is a useful keyboard shortcut and will become second nature as you become familiar with
the system.

48 of 61



= Local variables

c=7

El Fl_.lnu:tiu:un Argquments

a=>5

The debug window reflects the change of c.
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=10l x|

'. main.cpp [debuqg] - Code::Blocks ¥1.0 =
Filz= Edit “ew Search Project Buld | Debug  wxSmith  Tools  Plugins  Settings  Help

| EES|R YLD B F8
I 6 Stop debudger sddemint a, ink bl : int
Q P Q f;] 6 |Eiui|-:| target:lDeI:ul lr'g" Conkinue P. ?} {? Q | : i.
| ! !!! !|! ! main.cy ?}3' Mext line F7 4 b =
Projects 1 F 1 {3 Mextinstruction Al-F7
=) Workspace Z ™ Stepinto Shift-F7
= 3
=g debug 4 4% stepout Chrl-Shift-F7
EHE. Sources c
- mair, cpp . Togale breakpaink F5
7 LE'- Run to cursor F4
2
o Add symbal File
10 Debugaging windows 3
ié Information L
W |5 Edtwatches..,
0 d Fil
. F.'E“E_ res L Aktach to process, ..,
i || main, cpp 15
16 Detach
17
e Send user command to debugger
15 cout << =z << endl;
zZ0
z1l return 0O;
2z }
23
4 | [
(Continue exe WINDOWS-1252 LLirie 11, Calumn 1 Insert | Readfwrite

When you are done debugging, you can click on Continue and your program will run to
completion. This is better than selecting to Stop debugger. The reason it is better to Continue, is
because the program comes to a natural end, rather than aborting. However if your program is stuck in
a loop, or you are sure you can exit safely, you can select from the Debug menu Stop Debugger.
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=101 %]

'. main.cpp [debug] - Code::Blocks ¥1.0 -
File Edit Miew Search Project Build | Debug  wxSmith  Tools  Plugins  Settings  Help

1 EE SR YK Bt Fa
I &3 5top debunger bddern(int a, int b ¢ int
Sbh L e |Eiuilu:| target:IDebl LIE continue arrr 2T D | m
‘Management X [main_q T rext line F7 4 b x
Projects 1 b 1 ?}" Mext imstruckion AlE-F7
=14, Workspace Z ¥ Stepinto Shift-F7
.. 2
=g debug 4 48 Stepout Chrl-Shift-F7.
EHE SOurces c
(- j main. cpp & T|:||;||;||E: hr'E:.al::pljirm
7 LE'- Run ko cursar F4
g
a Add symbal File
10 Drebugging windows r
E Information ]
r 1= Edit watches...
0 d Fil
7 F_'E“FT. res L Attach to process. .
s j main.cpp 15 H
15 [ekac
17
e Send wser cammand ba debugaer
1a cout =< =z << endl;
za
zl return 0O;
2z }
3
Jl | [C1
Toagle breaky WINDOWS-1252 Ling 9, Calurn 9 Insert | Readfwrite

You can further define places in your program to pause and allow you to inspect the code. This is done
by setting breakpoints in your code. You can have zero or more breakpoints in your code. When the
debugger encounters a breakpoint, the program pauses and the debugger will allow you to inspect your
code. The breakpoint remains until you remove it. It can be Toggled with F5.
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'. main.cpp [debug] - Code::Blocks ¥1.0 _|I:I|5|
File Edit Wew Search Project Buld Debug  wxSmith  Tools  Plugins  Setkings  Help

T =E SR Y[R R R

I jladdeml{int a, int b 1 ink

Q D q E a |Builu:| target:lDebug j IE LE ?}}' e ?} {'? 6 | :-l_ i

T o
Projects | 4 1 finclude <iostreams
E..O WDFkSDaEE Z using namespace std;
El!l debug = ) ) )
== Sources : int addemi{int, int);
~| main.cpp & [Jint addem{int a, int b |
7 int o;
g
2 '.' c=ath;
10
11 return c;
1z !
F 13
. Opened Files 14 int mwaini)
j main, cpp 15 =1
le int x=5, wv=2, =;
17
12 z=addemnm (x _ ¥
13 cout <=z << endl;
zn
z1 return 0;
iz b
z3
o | i
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A breakpoint has been set at line 9. The red circle indicates that there is a breakpoint in the code.
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The program is started by selecting from the Debug pull-down menu, Start. This will run the program
in the debugger until a breakpoint is encountered, at which point the program will pause.
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When the program pauses at the break point, a red circle with a yellow triangle mark will appear at the
breakpoint.
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You can set multiple breakpoints. The keyboard shortcut F5 allows you to toggle the breakpoint at any
line.
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This screen shows breakpoints on lines 9 and 19, but line 9 indicates that the code has executed to that
point.
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Selecting Continue from the Debugger menu will run the program till the next breakpoint.
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Now the program stops at line 19, because the program reached the second breakpoint.
Press Ctrl-F7 to continue. Now the program runs till the end of the program, because there are no
further breakpoints to encounter.
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When you exit Code:Blocks you may be presented with the following window.

x

@ Warkspace 'Default waorkspace' is modified, Do wou want to save it?

Say “Yes” to save the Workspace. This saves settings of the workspace you are working on.

You now know the basics of how to use the compiler, work with a project, and use the debugger. Good
luck with your programming!
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Appendix A

Installation of Code::Blocks for Mac OS X
and Linux

If you are using the Mac OS, you will need to do the following:

Pre-Install steps:

Here is a step by step instruction file for setting up X11 and XcodeTools for the Mac.

1. Make sure that X11 is installed in your system (check in your Application menu). If not, you'll
need to install it from your Mac OS disc.

o Insert the disc and find the optional packages installer, open it, check the X11 box, and
install from that.

o If you are using 10.1 through 10.3, you can download X11 from Apple.

2. Install Developer Tools: You may be able to skip this step, if you are using Mac OS X 10.4
Tiger and have installed the Developer tools.

o As atest, open up xterm. You cannot use terminal with Code Blocks. xterm is part of
X11 and that is why you'll need to have X11 installed.

o Runthe command gcc. If you get an error that there are no input files, that means gcc
exists and you are good to go. If you get an error saying the command is not found, you
need to install the Developer Tools.

o If you need to install the Developer tools, you can download them from Apple, or you
can install them from your Mac OS disc. Locate the Xcode installer on the installation
discs and double click to install. Check your discs for Xcode or Developer Tools.
Run the installer and install everything other than the documentation:

= For Mac OS X 10.3, you need to install Xcode Tools version 1.2 or later

= For Mac OS X 10.4, you need to install Xcode Tools version 2.2 or later

Download Code::Blocks. Uncompress the zip file and place CodeBlocks.app where you like it.
The suggested location is /Developer/Applications or ~/Applications.

Installation for Fedora 8 Linux:

Installing Code::Blocks
In a console window, become root and then execute the following command:
yum install codeblocks
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Running Code::Blocks
In the Applications Pull Down Menu, go to Programming and click on: Code::Blocks IDE
or
Open a console window and then execute the following command:
codeblocks

Installation for Ubuntu Linux:

Installation Instructions From:
http://forums.codeblocks.org/index.php/topic,8208.msg61085.htmI#msg61085

1) Add the repositories to /etc/apt/sources.list:

Open the file with a graphical editor as root. Paste the following line in a terminal:
gksu gedit /etc/apt/sources.list

Paste this at the end:

# codeblocks

deb http://1gp203.free.fr/ubuntu/ gutsy universe
# wx widgets

deb http://apt.wxwidgets.org/ gutsy-wx main

Note: Depending on what version of Ubuntu you are using, in step 1 you
may need to replace gutsy with feisty.

2) To make sure your package system trusts these sources. Add their keys.

Enter these two lines at the terminal:
wget -q http://1gp203.free._fr/public_.key -0O- | sudo apt-key add -
wget -q http://apt.wxwidgets.org/key.asc -0O- | sudo apt-key add -

And update the packages by entering the following lines on the terminal:
sudo apt-get update
sudo apt-get upgrade

3) Install Code::Blocks

Enter the following line in the terminal:
sudo apt-get install libcodeblocksO codeblocks libwxsmithlibO codeblocks-contrib

You are able to step 3 whenever you want you to get the latest nightly build.

You should see Code::Blocks in the Programming Languages listing of your programs.
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